
User's Guide

This manual describes how to use the Camera Shooting Software

photography application for the FUJIFILM Digital Camera FinePix S1 Pro.

Read it carefully to ensure that you use this product correctly.

Camera Shooting Software
for FinePix S1 Pro
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IMPORTANT
Be sure to read this page before using the Software Set.

Notes on the Software and User's Guide

(1) Unauthorized transfer or duplication of all or any part of the enclosed

software or User's Guide is forbidden.

(2) The enclosed software and User's Guide can be used with only one device.

(3) We accept no liability whatsoever for any loss or injury incurred by the

owner or any third party while using a device with the enclosed software or

User's Guide.

(4) Every effort has been made to ensure that the product is flawless. If any

defect is found that is due to a fault on the part of the manufacturer, the

product will be replaced free of charge, at our discretion. No responsibility is

accepted for defects not caused by the manufacturer.

(5) The contents of the enclosed software and User's Guide are subject to

change without notice.

• Microsoft, MS-DOS and Windows are trademarks of the Microsoft Corporation of the 

U.S. registered in the U.S. and other countries.Windows is an abbreviated term 

referring to the Microsoft Windows Operating System.

• Macintosh, iMac and Mac OS are registered trademarks of Apple Computer,Inc.

• IBM PC/AT is a registered trademark of the IBM corporation of the U.S.

• Adobe Acrobat is a trademark of Adobe Systems Incorporated of the U.S.

• SmartMedia™ is a trademark of Toshiba Corpration.

• All other company or product names are trademarks or registered trademarks of the 

respective companies.

Do not attempt to play the CD-ROM enclosed with this

product on an audio CD player.

Doing so could damage your hearing or could damage

your speakers or headphones.



Camera Shooting Software

3

IMPORTANT .............................................................................. 2

Preface ...................................................................................... 4

Using the Camera Shooting Software ........................................5

Connecting the Camera and PC ....................................................5

Launching the Camera Shooting Software ....................................6

Shooting Window Details ...............................................................7

Large Preview Window Details ......................................................9

Specifying the Photography Settings ...........................................10

Setting the Image Display Orientation .........................................13

Taking Pictures ............................................................................14

Selecting Images .........................................................................15

Checking the Image Histogram ...................................................16

Setting the File Format and Image Size for Saved Files .............17

Importing Images (Save files as...) ...............................................18

Importing Images (Save) ..............................................................19

Erasing Images ............................................................................21

Using Time-lapse Photography ...................................................22

Exiting the Camera Shooting Software ........................................25

Contents



Camera Shooting Software

4

Thank you for purchasing this FUJIFILM product.

This User's Guide describes how to use the Camera Shooting Software for FinePix S1

Pro (referred to hereafter as the Camera Shooting Software). The Camera Shooting

Software allows you to control your Digital Camera FinePix S1 Pro (referred to hereafter

simply as the camera), take pictures and specify the photography settings from a

personal computer. You can also use this software to import the images you have shot

into your PC and save them on your hard disk.

Preface



* The examples used in these descriptions are for Windows 98. The screens

shown on Macintosh computers are different, but the procedures are the same.

Connecting the Camera and PC

Refer to the Owner's Manual supplied with your camera for information on using the

camera.

CAUTION Do not connect the camera to your PC until you have installed the Camera

Shooting Software. Refer to the Camera Shooting Software Quick Start

Guide for information on installing the software.

1. Switch on your PC.

2. Connect the AC power adapter to the camera

and switch the camera on. In the Setup screen,

select "PC Mode > Shoot" and then close the

Setup screen.

3. Connect the camera to your PC using a

USB cable.

CAUTION • Only one camera can be

connected to the PC.

Successful operation is not

guaranteed if mult iple

cameras are connected all at

once.

• Connect the camera and PC

using a direct USB cable

connection. Successful

operation is not guaranteed if

the camera is connected

through a USB hub.

• If you are using Windows

2000, the "Digital Signature

Not Found" message appears

the first time you connect the

camera after installing the

Camera Shooting Software. Click [Yes] and continue with the installation.

Camera Shooting Software
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Using the Camera Shooting Software
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Launching the Camera Shooting Software

1. Click the [Start] button and select [Programs] - [Camera Shooting Software for

FinePix S1 Pro] - [Camera Shooting Software for FinePix S1 Pro].

On a Macintosh computer, double-click the [S1 Pro Shooting] icon.

2. After the opening flash screen, the Shooting window and Large Preview window

appears.
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Shooting Window Details

When you launch the Camera Shooting Software, the Shooting window appears.

(Time-lapse) settings button

Opens the " Time-lapse settings" dialog

box. This button can only be clicked

when the "Time-lapse photography"

checkbox is selected.

Camera option button

Switches to shooting from the camera.

When this button is selected, the

[Shoot] and [Shoot Settings] buttons

are disabled.

Host option button

Switches to shooting from the PC.

Time-lapse photography checkbox

Switches to "Time-lapse Photography"

mode. This mode cannot  be selected

when the [Camera] option button is

selected.

Focus lock checkbox

Locks the camera focus. This option is

disabled when the camera's focusing

mode is in "M(Manual)".

Shoot Conditions button

Opens the "Shoot Conditions" dialog

box. This button is disabled when the

[Camera] option button is selected.

Shoot button

Takes a picture on the camera from the

PC. This button is disabled when the

[Camera] option button is selected

Auto Acquire checkbox

Automatically imports the photographed

image onto the PC and saves it on your

hard disk.

(Time-lapse) settings
button

Focus Lock
checkbox

Host
option button

Shoot button

Time-lapse 
photography
checkbox

Camera
option button

Display orientation box

Scroll preview

Shoot Settings
button

Histogram button

Save file as...
button

Save button

Edit folder display

Clear button

Select All button

Set Folder button

File format box

Image size 
box

< Shooting window >

Auto Acquire 
checkbox



Camera Shooting Software

8

Histogram button

Opens the "Histogram" dialog box. This

button is disabled if no image is

selected or if mult iple images are

selected.

File format box and Image size box

Use these boxes to select the fi le

format and the image size when you

use the "Save" or "Save fi le as.."

function.

Display orientation box

Sets the orientation in which the

photographed image is displayed.

Clear button

Erases an image selected using scroll

preview from the camera's memory.

This button is disabled if no image is

selected.

Select All button

Selects all the images shown in the

scroll preview. This button is disabled if

there are no images in the scroll

preview.

Save button

Imports the image selected in the scroll

preview from the camera and saves it

to a file in the folder displayed in the

"Edit folder display" box. This button is

disabled if no image is selected.

Save file as... button

Imports the image selected in the scroll

preview from the camera and saves it

as a file on your PC. This button is

disabled if no image is selected.

Set Folder button

Opens the "Set Folder" dialog box.

Scroll preview

Shows previews of the images shot

using the camera or the images saved

in the camera memory.

Edit folder display

Shows the name of the folder to which

images are saved when you click the

[Save] button.



Large Preview Window Details

1. When you launch the Camera Shooting Software, the Large Preview window opens

at the same time as the Shooting window.

< Large Preview Window >

2. You can use the Large Preview window to check an image you have shot.

When you select an image in the Scroll Preview, the selected image is displayed in

the Large Preview window.

TIP • If you select "Fine detail" from

the "View" menu in the Large

Preview window or if you

simply double-click the

displayed image, the full-size

image (3040x2016) is imported

from the camera and displayed in the window.

• See " Selecting Images" (-> P.15) for more information on selecting an

image.

• It takes roughly 10 seconds to import an image displayed in fine detail

from the camera to your PC. Depending on the hardware and software

provided on your PC, it might also take some time to display the image.

For optimum performance, you should have at least 128 MB of additional

memory installed on your PC.

• To revert to the standard window size or image size, select "Normal"

from the "View" menu in the Large Preview window.

Camera Shooting Software
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Specifying the Photography Settings

1. Before taking a picture, use the procedure described here to check photography

settings such as the sensitivity and shutter speed and to change the settings as

desired.

When you click on the [Shoot Conditions] button in the Shooting window, the "Shoot

Settings" dialog box opens.

TIP When you launch the Camera Shooting Software, the photography

settings from the last time you used the software are set in the camera.

Also, after you exit the Camera Shooting Software, the photography

settings prior to launching the software are set in the camera.

2. If you specify the photography settings and then click the [Apply] button, the settings

are transferred to the camera.

• Clicking the [Apply] button validates the settings currently shown in the "Shoot

Conditions" dialog box.

• Clicking the [Open] button opens the "Open file" dialog box and allows you to

import a photography settings file saved on the PC.

• Click the [Save as...] button to open the "Save file as..." dialog box and save the

photography settings currently shown in the "Shoot Settings" dialog box as a

photography settings file on your PC.

• Clicking the [Default] button restores the current settings in the "Shoot Settings"

dialog box to the default values. The initial default settings are as follows:

Sensitivity : ISO 400

Exposure : Auto

Exposure Compensation : 0

White Balance : Auto

Camera Shooting Software
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• Clicking the [Cancel] button discards the current settings and closes the "Shoot

Settings" dialog box.

Sensitivity

Selects the ISO film speed. The following 4 film speeds can be selected:

ISO 320, ISO 400, ISO 800 or ISO 1600

Metering

Displays the metering mode set on the camera. The following 2 types of metering

mode can be displayed:

Multi-Pattern /  Center-Weighted

Refer to the Owner's Manual for the camera for details.

Exposure

Selects the exposure mode. The following 10 types of mode can be selected:

Auto / Programmed Auto / Aperture-Priority 

Auto / Shutter-Priority Auto / Manual / Portrait /

Sports / Night scene / Landscape / Close-up

You can also set the exposure compensation value by moving the button on the

slider bar. You can set the exposure compensation value in the Programmed

Auto, Aperture-Priority Auto, Shutter-Priority Auto and Manual exposure modes.

Refer to the Owner's Manual for the camera for details.

Shutter Speed

Selects the shutter speed. This can be selected when the aperture mode is set to

Shutter-Priority Auto or Manual.

Aperture

Selects the aperture setting. This can be selected when the aperture mode is set

to Aperture-Priority Auto or Manual.

White Balance

Selects the white balance mode. The following 8 types of white balance mode can

be selected:

Auto / Custom / Fine / Incandescent Light / Shade (fine weather)

Fluorescent Light 1 / Fluorescent Light 2 / Fluorescent Light 3

Refer to the Owner's Manual for the camera for details.

Camera Shooting Software
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AWB

Performs "one-push AWB" (automatic white balance setting). This option can be

specified when the white balance mode is set to "Custom".

TIP Set the white balance mode to "Custom" and click the [Apply] button to

enable the [AWB] button.

To perform "one-push AWB":

1  Hold up a piece of white paper in front of the viewfinder so that completely

covers the area photographed.

2 Click the [AWB] button. The shutter operates exactly as if the camera was taking

a picture and a white image is stored in the camera memory. The camera then

automatically sets the white balance based on the captured image.

3  Because the automatically set image is displayed in the scroll preview in the

Shooting window, you can visually check the results of "one-push

AWB".Subsequently, when you select "Custom", the camera uses the

automatically set white balance to take the picture. To change the "Custom"

white balance, click the [AWB] button again.

CAUTION • If you click the [Save] button to save photography settings file, do not

use "Initial 60", "System 60" or "Camera 60" as the file name since these

names are used by the Camera Shooting Software.

• if the "Cannot take the picture - the Camera is out of focus" message

appears, tick the "Focus lock" checkbox or set the camera focusing

mode to "M(Manual)" and then perform "one-push AWB".

TIP • You can enter a short comment for each set of photography settings.

This comment is saved in the photography settings file when you click

the [Save as...] button.

• If you open the "Shoot Conditions" dialog box after launching the

Camera Shooting Software, the current camera settings are imported

and displayed.



Setting the Image Display Orientation

1. The "Display orientation" box sets the orientation in which photographed images are

displayed. The orientation specified here governs the way images are displayed in

the Scroll Preview and Large Preview window.

2. Click on the arrow button in the "Display Orientation" box and select the display

orientation. The following 4 orientations can be selected:

Rotate Off

The image is displayed unrotated.

Rotate 90 - cw

The image is displayed rotated 90° to the right

Rotate 90 - ccw

The image is displayed rotated 90° to the left.

Rotate 180 -

The image is displayed rotated 180°.

TIP • When the Camera Shooting Software is launched, images in the Scroll

Preview are displayed with the orientation set in the "Display Orientation"

box.

• Photographed images are always saved to files unrotated.

Camera Shooting Software
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Taking Pictures

When you have specified the photography settings and the display orientation, you are

ready to take pictures on the camera.

1. When the "Host" option button is selected, click the [Shoot] button in the "Shoot"

window to take a picture. If the "Camera" option button is selected, press the shutter

button on the camera.

If you take a picture when the "Focus lock" checkbox is ticked, the camera releases

the shutter immediately without performing auto focusing. If the "Focus lock"

checkbox is not ticked, the camera's auto focusing feature operates and the shutter

releases after the image is focused.

CAUTION • If the shutter does not release when you click the [Shoot] button, set the

focus mode on the camera to "M(Manual)" or tick the "Focus lock"

checkbox before shooting.

• If you tick the [Auto Acquire] checkbox before shooting, the

photographed image is saved on the PC and then automatically erased

from the camera memory.

If you tick the [Time-lapse photography] checkbox before shooting, time-lapse

photography is performed.

See " Using Time-lapse Photography" (-> P.22) for more information on time-lapse

photography.



2. When you take the picture, the image is stored in the camera's memory and

displayed in the "Scroll Preview" in the Shooting window.

TIP Up to 5 shots can be taken on the camera. To continue taking additional

pictures, erase some unwanted images or save the images to your PC

and then erase them. Then continue taking pictures.

Selecting Images
To select an image in the Scroll Preview, simply click the image. The selected image

appears as a depressed button.

To cancel an image selection, click another image. To select multiple images, hold

down the [Ctrl] key and click the images with the left mouse button.

On Macintosh computers, hold down the [Shift] key and click.

You can also select multiple images in either of the following ways:

• Hold down the [Ctrl] key and as you click other images.

On Macintosh computers, hold down the [Shift] key as you click.

• Click the [Select All] button.

Camera Shooting Software
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Checking the Image Histogram

Before you save a photographed image, you can use the histogram to check the color

distribution in the image.

1. Select the image to be checked and click the [Histogram] button in the Shooting

window. The Histogram dialog box then appears.

2. Click the arrow in the [channel] box to select the color to be shown in the histogram.

The 4 settings that can be selected are "Master", "Red", "Green" and "Blue".

When you have checked the histogram, click the [Close] button to exit the Histogram

dialog box.

CAUTION • You can only use the Histogram dialog box to check the color

distribution, not to modify it.
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Setting the File Format and Image Size for Saved Files

Before you save a photographed image, set the file format and the image size.

1. Select the file format to be used when the image is saved in the "File format" box in

the Shooting window. The following 5 file formats can be selected:

Exif-JPEG (Basic) Exif-TIFF (YCC)

Exif-JPEG (Normal) Exif-TIFF (RGB)

Exif-JPEG (Fine)

Refer to the Owner's Manual for the camera for details.

2. Select the image size to be used when the image is saved in "Image size" box in the

Shooting window. The following 3 image sizes can be selected:

1,440 X 960 2,304 X 1,536 3,040 X 2,016



Importing Images (Save files as...)

There are two functions that import photographed images to your PC: "Save file as..."

and "Save".

Save file as...:

In this function, you specify the folder in which the image file is to be saved and the file

name to be used when the image is imported. Select the image to be saved and click

the [Save file as...] button in the Shooting window.The images in the camera memory

are imported to the PC and the "Save file as..." dialog box appears.

Specify the save destination folder and file name and then click the [Save] button. The

image is saved under the specified file name.

TIP • See " Selecting Images" (-> P.15) for more information on selecting an

image.

• When an image is saved, the file format and image size specified in the

Shooting window are used. See "Setting the File Format and Image Size

for Saved Files" (-> P.17).

• You cannot open and view a saved file in the Camera Shooting

Software. Use the Exif Viewer software application provided on the

enclosed CD-ROM.

Camera Shooting Software
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Importing Images (Save)

Save:

This function saves the photographed image to a destination folder specified

beforehand and automatically generates a file name.

1. Specify the destination folder before using the Save function.

Click the [Set Folder] button in the Shooting window to open the Set Folder dialog

box.

2. Select the drive and then the folder from the pull-down lists to specify the destination 

folder.

• Click the [Set] button to validate the specified settings and close the Set Folder

dialog box.

• To discard the settings and close the Set Folder dialog box, click the [Cancel]

button.

3. The selected folder and the file format to be used for saving the file appear in the

"Edit folder display" box.

Select the image you want to import and click the [Save] button in the Shooting

window.

The image on the camera is transferred to the PC and saved to the destination folder

shown in the "Edit folder display" box.



TIP • See " Selecting Images" (-> P.15) for more information on selecting an

image.

• When an image is saved, the file format and image size specified in the

Shooting window are used. See "Setting the File Format and Image Size

for Saved Files" (-> P.17).

• You cannot open and view a saved file in the Camera Shooting

Software. Use the Exif Viewer software application provided on the

enclosed CD-ROM.

• File names are automatically assigned in the "DSCFxxxx.jpg" or

"DSCFxxxx.tif" format (where "xxxx" is a number between 0000 and

9999).

• The setting in the "Edit folder display" box is saved.

Camera Shooting Software
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Erasing Images

To erase an image you have photographed, select the image to be erased and click the

[Clear] button.

If you click the [select All] button and then click the [Clear] button, all the images

displayed in the Scroll Preview are erased.

TIP • See " Selecting Images" (-> P.15) for more information on selecting an

image.

• When you erase an image, the corresponding frame in the Scroll

Preview turns gray to indicate that no image has been shot. The

remaining images are not rearranged to fill the gap. When you shoot new

images, they appear sequentially in the vacant (gray) frames in the Scroll

Preview.

Camera Shooting Software
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Using Time-lapse Photography

Time-lapse photography shoots a specified number of images at a set specified interval

and then saves the images.

1. Set the interval between shots and the number of shots to be taken.

Tick the [Time-lapse photography] checkbox in the Shooting window.

2. The [(Time-lapose) Settings] button in the Shoot window is enabled. Click the [(Time-

lapose) Settings] button to open the "Time-lapse photography settings" dialog box.

Specify the settings and then click the [Set] button to apply the settings.

• Clicking the [Set] button validates the specified settings and closes the "Time-lapse

photography settings" dialog box.

• Clicking the [Cancel] button discards the specified settings and closes the "Time-

lapse photography settings" dialog box.

Save Destination Folder

Select the drive and then the folder from the pull-down lists to specify the

destination folder.



File format

Select the file format to be used when the image is saved. The following 5 file

formats can be selected:

Exif-JPEG (Basic) Exif-TIFF (YCC)

Exif-JPEG (Normal) Exif-TIFF (RGB)

Exif-JPEG (Fine)

Refer to the Owner's Manual for the camera for details.

Image size

Select the image size to be used when the image is saved. The following 3 image

sizes can be selected:

1,440 X 960 2,304 X 1,536 3,040 X 2,016

Number of shots

Specifies the number of shots taken in time-lapse photography. The valid range

for the number of shots that can be taken is displayed beforehand. Specify a value

in the displayed range.

Interval between shots

Specifies the time interval between shots taken in time-lapse photography. The

valid range for the interval between shots is displayed beforehand. Specify a value

in the displayed range.

3. When you have specified the time-lapse photography settings, check that the "Time-

lapse photography" checkbox is ticked and then click the [Shoot] button in the

Shooting window. Time-lapse photography begins and the "Shooting time-lapse

pictures..." message appears.

Camera Shooting Software
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4. When the specified number of time-lapse photography shots has been taken, the

[Close] button is enabled. Click the [Close] button to close the "Shooting time-lapse

pictures..." message box.

• Clicking the [Cancel] button stops time-lapse photography stops and closes the

"Shooting time-lapse pictures..." message box. The images that have already been

saved to files on the PC are left on the PC.

5. The settings specified in the "Time-lapse photography settings" dialog box are

displayed in the upper part of the "Shooting time-lapse pictures..." message box.

The bottom half of the "Shooting time-lapse pictures..." message box shows the

progress information for time-lapse photography. The following types of progress

information are displayed:

Time remaining before next shot

Counts down the time remaining to the next shot.

Estimated completion time

Shows the predicted finishing time for time-lapse photography.

Number of time overrun frames

Displays the number of shots where shooting and saving to file could not be

completed in the specified interval between shots.

The number of time-overrun frames may increase due to factors such as the PC

processing load. In this event, click the [Cancel] button in the "Shooting time-lapse

pictures..." message box to stop time-lapse photography, reset the interval

between shots and then begin time-lapse photography again.

Largest time overrun

Displays the time taken by the longest time overrun. When you reset the time

between shots, set a new value that is at least as long as the current time

between shots plus the largest time overrun.

TIP • The time-lapse photography settings are saved provided they are not

modified.

• You cannot open and view a saved file in the Camera Shooting

Software. Use the Exif Viewer software application provided on the

enclosed CD-ROM.

• File names are automatically assigned in the "DSCFxxxx.jpg" or

"DSCFxxxx.tif" format (where "xxxx" is a number between 0000 and

9999).

• To ensure stable operation during time-lapse photography, insert the

battery-type adapter into the camera and connect the AC power adapter.

• If the "Flash charging..." message appears, reset the time-lapse

photography settings with a larger interval between shots.

Camera Shooting Software
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Exiting the Camera Shooting Software

To exit the Camera Shooting Software, select "Exit" from the "File" menu in the

Shooting window. On Macintosh computers also, select "Exit" from the "File" menu.

You can also exit the Camera Shooting Software by clicking the Close button in the top-

right corner in the Windows version or the Close box in the top-left corner in the

Macintosh version.
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